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Dear Customer: 
 
Thank you for choosing PC-Planner, C-Map’s at-home planning tool. 
 
PC-Planner brings the power of your chart plotter into the comfort of your own 
home! 
 
After years of suggestions and feedback this manual has been redesigned to add 
more detailed instruction and provide an easier to read media to fully unlock the 
power of your PC-Planner. 
 
As we continue to grow and improve the PC-Planner program we encourage any 
and all feedback. 
 
Although PC-Planner is a simple, easy-to-use program, we urge you to review 
this User Manual and Quick Reference Guide prior to operation. 
 
Should you have any questions or concerns not addressed in these pages, please 
do not hesitate to our Technical Support department at 800.424.2627. 
 
 
Thank you, 
 
C-Map 
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1. Introduction 
 
The PC-Planner is designed to turn your home computer into a navigational planning tool.  Using the same C-Map 
electronic chart C-cards that you use on your boat, it is possible to display all of your electronic charts in full color 
on your PC screen.  The PC-Planner can be used for viewing charts, zooming, panning, entering user points, 
creating routes, and entering A-B functions.  In fact, every planning function of your chart plotter is now easy to 
do on your PC. 
 
PC-Planner runs in full capacity only if C-Map USB reader is connected to your PC.  The three available readers 
are the orange Multimedia (MM) Reader, the single-cartridge Furuno (FP) Reader, and the dual slot C-card (CC) 
reader.  These readers transmit the chart data to the PC and also allow programming of C-MAP User C-cards and 
Furuno Memory Cards. 
 
NOTE: Please check with your dealer regarding the compatibility of your chart plotter with these 

User C-cards. 

 
 

2. PRODUCT SPECIFICATION 
 

2.1. Requirements 
 

• Windows 95/98, ME, 2000, XP 
• 32MB RAM 
• 40MB free Hard Disk 
• Video Resolution: 800x600 or higher 
• Video Colors: 65536 (high-color, 16bits) 
• Available USB port. 
• CD-ROM with installation software 
• One of the following USB Readers: 
 
 

       
USBCC reader         USBFP reader               USBMM reader 

  
• USBCC Reader – The original PC-Planner reader.  Compatible with C-cards only in most NT+ and MAX 

chart plotters. 
• USBFP Reader – Compatible with FP-cards only in the Furuno Navnet1 series of chart plotters. 
• USBMM Reader – The newest PC-Planner reader.  Compatible with C-cards in most NT+ and MAX chart 

plotters and SD-cards in all MAX chart plotters. 
 

 
 

Please check out the PC-Planner WEB Site for RELEASE NOTES for the latest version. 
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3. INSTALLATION 
 
If you have a previous version of PC Planner software installed on your PC, it is necessary that you uninstall it 
first. To do so, you should use the Uninstall function in Control Panel, called Add or Remove Programs.   
Also please keep in mind that removing a previous installation will remove ALL user data stored in PC-Planner.  
Backing up to your hard drive or User C-card is recommended before uninstalling the software. 
 
Inserting the PC-Planner CD-ROM into your PC, the PCPNTAutoRun software will be launched allowing you to 
select the language of the installation, English or Italian.   
 
PLEASE NOTE: You MUST NOT plug in the USB readers prior to installation of the drivers.  Doing so 

can disrupt the flow of the installation process and can lead to lengthy technical support issues 
getting the drivers and your PC in sync.  During the Driver installation you will be prompted to plug 

in the USB reader, and only then should you do so. 
 
 

 
 
After choosing your desired installation language, the following dialog box will appear: 
  

  
 
To begin the installation process, select Install PC-Planner and follow the on-screen messages in the dialog 
boxes that appear.   
 
 

Install PC-Planner – This will launch the SETUP program for PC-
Planner 
 
Read the User Manual – This will let you review the user manual in 
an easy to read HTML interface 
 
PC-Planner on the Web – This will take you to the PC-Planner 
website where you can register to be notified of important software 
updates.  
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The next dialog box displays the components you can install for PC-Planner: 
 

 
 

The figure above depicts the default installation settings.  It is important to ONLY have the drivers selected for 
the reader device you own.  WARNING: Installing all of the reader drivers will lead to problems during the 
installation of the reader. 
 PC-Planner    => This is the core PC-Planner software 
 USB C-card Reader Drivers  => Necessary for using the USBCC Reader for C-cards 
 Multimedia Reader Drivers => Necessary for using the USBMM Reader for SD or C-cards 
 FP-Card Reader Drivers => Necessary for using the USBFP Reader for Furuno cards 
 Parallel Port Reader Drivers => Necessary for using the PPCR Parallel Port Reader for C-cards 
 Demo charts   => Installs several small chart areas for use in DEMO mode 
 
After choosing which components to install, click on Install to enter into the installation phase. During the 
installation process, please follow the on-screen instructions.  There is no customization necessary, and you 
should simply click Next all the way through the installation until the following message appears: 
 

 
 

There is no message displayed as each component is installed.  The Installshield sequence will launch right into 
the next component as soon as the previous one is completed.  After you see the message above, click OK and 
the installation will be complete. 
 
The PC-Planner program is now accessible from either your program list (through the START menu) or from the 
PC-Planner icon on your desktop:   
 

 
 
Use this icon to open PC-Planner and begin planning your C-Map based voyage.... 
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4. GETTING STARTED 
 
There are two modes that PC-Planner can operate in.  One is DEMO Mode, and one is the fully registered version.  
DEMO mode can be triggered by either running the software without a USB reader attached (see Section 4.1), or 
if the drivers for the USB Reader are not synced correctly with the PC (please refer to the Troubleshooting section 
at the end of the manual for correcting this problem).  If you connect a reader and the drivers were installed 
correctly, then PC-Planner will launch normally (see Section 4.2). 
 

4.1. DEMO Mode 
PC-Planner now offers a Demonstration Mode which offers limited functionality to introduce you to the PC-
Planner environment.  There is a limit of 10 user points in any combination (routes, routes and marks, marks 
only, etc) and there is no capacity for transferring data to User C-cards or to the PC.  If you selected Demo 
Charts during the installation process, there will be select areas available as if the C-cards were loaded.  They 
can be accessed through the User Data -> Present Data Cartridges dialog box in PC-Planner. 

 

 
 

Highlighting any of the demo areas and then using the Locate button will bring you to that area where you 
can then see the chart data and zoom in and get acquainted to the C-Map format. 
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4.2. Unlocking PC-Planner 
The first time that PC-Planner runs with a USB reader attached, it is necessary to enter a registration code. 
The registration code is unique to your USB reader, and should be found in the Introduction letter included 
with the PC-Planner package.  If you did not receive a letter, or have recently upgraded your software, a new 
registration code can be obtained from your local C-Map office or through the secure portion of the PC-
Planner website at http://pcplanner.c-map.it   

 

 
 

If the registration code is accepted, then the World Map will be displayed, usually at the 0° Lat, 0° Long 
position off the coast of Africa.  Local chart data is only viewable once a chart card is inserted into the USB 
reader. 

 

4.3. Inserting a chart card (C-card, SD-card or FP-card) 
The USBCC reader can read from 2 C-cards at once.  The USBFP reader is able to read one FP-card at a time 
as it only has 1 slot in it.  The USBMM reader can read from one C-card or one SD-card at a time.  Once the 
C-cards are inserted, they should be automatically detected by PC-Planner.  If you are in the designated 
coverage area, then the chart borders will become instantly visible.  If you are not in the designated coverage 
area then go to User Data -> Present Data Cartridges to see a list of the loaded C-cards.   You can find your 
C-card in the list and click on the Locate button to take you to the C-card. 

 

 
 

 The Background Cartridge will always be present. You can enable or disable the present cartridges with the 
exception of the Background Cartridge and any User C-cards. 

 
 While chart cards display the data automatically in PC-Planner when they are inserted, the User C-cards need 

to have the data loaded into PC-Planner via the File Manager (see Section 9).  
 

4.4. Removing a chart card (C-card, SD-card or FP-card) 
 
C-cards can be freely removed from the USB Reader while the PC-Planner is running.  It is recommended that 
this is done only from the background chart and to make sure you zoom all the way out before removing any 
C-cards.  If you attempt to remove a C-card while the data is being accessed from the C-card, such as on a 
nav-aid or chart details, it can cause PC-Planner to lock up or crash. 

 

Reader ID 
This 16 digit 
number is 
used to 
generate a 
Registration 
Code. 
 

Registration Code 

Found on either the 
letter or via the 
website, the 
registration code is 16 
digits and should be 
entered to replace the 
zeroes. 
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5. PC-PLANNER SETUP 
 
PC-Planner has several settings that will allow you to customize your display to show as little or as much chart 
detail as possible.  There are also settings for personal preference on lat/long display, language and others.  This 
section will review these settings in PC-Planner and how to change them. 
 
To change the settings, the dialog boxes are all found under View -> Settings from the main PC-Planner screen.  
This brings up a window with several tabs of options.  Each of the tabs is elaborated on below: 
 

5.1. General PC-Planner Setup (Setup tab) 
 

 
 

5.1.1. Language 

 
 

5.1.2. NMEA I/O Serial Port/Baud Rate 

    
 
 
 

PC-Planner can operate in English, Italian or 
French.    
 

PC-Planner can use serial port connections to read 
data from non compatible chart plotters and 
handheld GPS devices.  The Serial Port selection 
and the Baud Rate setting allow you to choose 
which port PC-Planner looks for and at which 
speed it will communicate. 
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5.1.3. Serial Interface 

 

 
 

5.1.4. Printing 
 

 
 
 

5.1.5. File Format for File Manager 

 
 

 
 
 

5.1.6. Chart Emulation Settings 

PC-Planner is built to be compatible with all of the C-Map family of plotters.  Some plotters require 
different formats for waypoints, tracks and routes, and as such, PC-Planner has a variety of emulation 
modes available: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

This setting defines the communication method on the Serial ports.  
NMEA is the default setting and really never needs to be changed as 
nearly all GPS devices communicate via NMEA. 
 

Using the File Manager in PC-Planner, you can save your user data to 
the hard drive in one of two formats; Text (TXT) or Extended Markup 
Language (XML).  XML is the preferred setting as it is more readily 
convertible in the chart plotter world if you ever want to import the 
data into other programs. 
 

When connected to a printer, PC-Planner can be used to print out 
snapshots of the chart data on screen and to also print out lists of 
user data (marks, routes, etc).  To print in color (if applicable) check 
off Print in Color in this setting. 
 

Generic  For all C-Map compatible plotters that do not fall into the specific categories 
below.  Generic mode has 16 different icons, all with black color, that can 
be used for Marks and Routes. 

Furuno Navnet1   For all Furuno NavNet1 plotters.  Requires the USBFP Reader to work.  
Furuno Navnet 1 mode has 7 different icons for Marks and 16 different 
icons for Waypoints/Routes.  Each of which can be assigned one of 7 
different colors.  Marks CANNOT have a name or description, only 
Waypoints can. 

Furuno Navnet2  For all Furuno NavNet2 plotters.  Requires the USBMM reader and an SD-
card.  Furuno Navnet 2 mode has 7 different icons for Marks and 16 
different icons for Waypoints/Routes.  Each of which can be assigned one 
of 7 different colors.  Marks CANNOT have a name or description, only 
Waypoints can. 

Furuno GP-7000  For the Furuno GP-7000.  Requires the USBMM reader and an SD-card.  
Furuno GP-7000 mode has 16 different icons that can be used for Marks 
and Routes.  Each of which can be assigned one of 8 different colors. 

Navman 8xxx  For the Navman 8 inch plotters.  Requires the USBMM reader and an SD-
card. 

Northstar M Series  For the Northstar M series plotters.  Requires the USBMM reader and an 
SD-card. 

Fish-12 SD  For plotters that read cartography from c-card and use a SD-card for user 
data (e.g. Fish-12).  Requires the USBMM reader and both C-CARD and SD-
card for full functionality. 
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The default emulation is Generic.   
 

 
 

5.2. General Chart Settings (General tab)  
 

 
 

5.2.1. Basic Chart Features 
The first 4 check boxes on this page are for basic chart features common to PC-Planner:  
 

 
 

5.2.2. Mixing Levels 

Mixing Levels is one of the advanced C-Map chart features where detail from a lesser scale is merged 
with greater detail scales to fill in gaps.  For instance, if there is an inset for a specific harbor, but no 
detail outside the harbor, Mixing Levels will fill it in with a ‘virtual chart’.  Mixing Levels data is designated 
by a dotted fill pattern, as seen in the images below: 
 
5.2.3. Value Added Data 
This setting will turn off all Port Info, Tide Icons, Current Vectors, Photos, Points of Interest, etc, that are 
present on the C-card.  Essentially it strips the C-card of all data that is NOT embedded chart data. 
 

Names     Turns all names (text) On or Off. 
Lat/Lon Grid    Turns the Lat/Long Grid On or Off. 
Chart Boundaries   Turns the chart boundaries On or Off. 
Aeronautic Gray Mode   Toggles the chart between full color and 

Aeronautical grayscale 
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5.2.4. Preferred Cartography 

 

 
 
 

5.2.5. Objects Presentation 
 

 
 
5.2.6. Zoom Mode 
 

 
 
 
5.2.7. Coordinate System 
PC-Planner has a series of different coordinate formats available: 
 

 
 
 
 
 
 
 
 
 

 
 

5.2.8. Units 
 

  

This setting dictates the highest priority chart data.  Each of the three 
settings, Marine, Terrestrial and Aeronautic has different palettes and 
presentation parameters to suit that level of application.  The default 
setting is Marine, and in most cases should stay that way. 
 

This setting is a basic form of anti-clutter on the chart.  In Single mode, 
clumps of chart objects will be displayed as one icon, rather than by its own 
individual icon like in Multiple mode.  It’s simply a way to declutter the 
screen in a known area. 
 

This setting changes how and how much you can zoom into any given 
chart.  Standard zoom level is 1-2 levels of zoom per chart scale level.  
Flexi-Zoom allows you to lock on a specific scale of charts and zoom in or 
out up to 6 additional times.  Flexi-Zoom unlocks the quick zoom feature on 
the toolbar (see Section 6.2.2). 
 

DDD MM SS    Degrees, Minutes, Seconds 
DDD MM.MM    Degrees, Decimal Minutes to 2 decimal places 
DDD MM.MMM   Degrees, Decimal Minutes to 3 decimal places 
UTM  Universal Transverse Mercator.  A special grid adapted by NIMA for military 

use around the world 
OSGB     Ordnance Survey of Great Britain.  The British version of the UTM grid. 
TD     Time Difference.  The old coordinate system based on Loran.  
 

This setting controls the distance, depth, height and speed units in PC-
Planner.  Distance can be Nm, Sm, Km, m, ft.  Depth/height can be fm, ft, 
m.  Speed can be Knots, Km/h, mph. 
 



 

Last Revision: November 27, 2007 

 
5.2.9. Miscellaneous 

 

 
 

5.2.10. Daylight Savings Time 
 

 
 
 

5.3. Marine Chart Settings (Marine tab) 
 

 
 
 
 

5.3.1. Lights settings 

 
 

 
 

This setting is the universal control for Daylight Savings time.  It is 
important to use this especially for Tidal and Current predictions.  
 

This setting controls the Default Speed for route calculations and the 
Bearing for the A-B function and for the route calculations.  Bearing can be 
either True or Magnetic. 
 

This setting controls the Lights on the charts.  
Lights Enable turns them On or Off.  Display Sector 
turns On or Off the circlular sectors around the 
lights. 
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5.3.2. Advanced Chart settings 

 
 
 
 
 
 
 
 
 
 

 
 

5.3.3. Marine Presentation 
 

 
 
 
 

   
 

       International Marine Presentation      American Marine Presentations 

These settings control some of the advanced features of C-Map charts: 
Attention Areas   Toggles Caution Areas, Anchorage Areas and the likes On/Off. 
Depth Area Limit  Defines the depth areas on the chart to be shaded. 
Depth Lines & Soundings Defines the range of depth contours and soundings to be displayed 

on the chart 
Tracks & Routes  Toggles Recommended Tracks On/Off 
Spot Soundings  Toggles spot soundings On/Off 
Buoys & Beacons  Toggles all Nav-aids On/Off 
Bottom Type   Toggles seabed points and areas On/Off 
Buoy Names   Toggles the display of buoy names/numbers On/Off 
 

This setting controls the presentation of the nav-
aids on the chart.  American uses standard NOAA 
symbology while International uses a more true-to-
life presentation. 
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5.4. Land Chart Settings (Land tab) 
 

 
 

 These settings control the amount of detail displayed on land: 
� Natural Features   Toggles Land Elevation areas On/Off 
� Rivers & Lakes  Toggles River and Lakes On/Off 
� Cultural Features  Toggles Airports On/Off 
� Landmarks  Toggles Towers, Silos, Tanks, Monuments, etc On/Off 
� Roads   Toggles roads On/Off 
� Railways   Toggles Railroads On/Off 

 

5.5. Aviation Chart Settings (Aviation tab) 
 

 
 

These settings control the amount of detail displayed when used with an Aeronautical C-card.  For all 
intents and purposes, this is not used with marine C-cards and thus will not be covered in this guide. 
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5.6. Route Checking Settings (Route Checking tab) 
 

 
 

PC-Planner includes a powerful Route Checking feature that will search the chart data during Route 
creation to check for any of the designated features found in this dialog box.   

• Land Areas   Will check all chart layers for any land or islands. 
• Underwater Rocks  Will check for underwater rocks 
• Intertidal Areas  Will check for areas that are emerged at low tide 
• Insufficient Depth  Will check for areas that do not have enough depth as defined 

by the Depth setting 
• Shoreline Constructions Will check for docks and other shoreline construction  
• Obstructions   Will check for fish havens, wrecks, etc 
• Fishing Facility  Will check for fishing facilities 
• Width    Defines the width of the check along the route leg.  Displays as 

a light green shaded area around the route leg as you draw the 
route. 

• Depth    Defines the depth that you need in the route 
 

If any of the following criteria are met during the route creation, a warning will be displayed: 
 

 
 

Clicking yes will continue on with the route creation, while clicking no will invalidate the last point 
entered, but still leave you in route creation mode where you just need to select a new point. 
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In the image above, the area shaded in green has been ‘route checked’ by PC-Planner for all hazards 
defined on the Route Checking tab.  The black area is where the new leg of the route is being drawn.  
The shading allows you to see the area being checked and it is defined by the Width setting on the Route 
Checking tab. 
 
The Route Checking mode can also be enabled or disabled from the PC-Planner toolbar by clicking on the 

Route Checking icon  
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5.7. C-Weather Settings (C-Weather tab)  
 

 
 

This panel controls the configuration of data for C-Weather.  C-Weather is C-Maps proprietary weather 
download feature.  It allows you to download weather information from the internet and program it to a 
User C-card via PC-Planner for upload into your chart plotter.  The weather data includes temperature, 
wind speed and direction, wave height and direction, weather conditions (sunny, clear, cloudy, etc), 
humidity and visibility for a 4 day period.  This panel controls the settings for all of this, and weather will 
be covered in more detail in Section 11. 

 
 The settings that can be controlled for C-Weather are: 
  

Server Address  IP Address where the weather data is downloaded from.  This should 
never be changed. 

 Temperature Units  Fahrenheit or Celsius 
 Wind Speed Units  Knots, miles per hour (mph) or meters per second (m/s) 
 Wave height Units  Feet (Ft) or Meters (m) 
 Visibility Range Units  Nautical Miles (Nm) or Kilometres (Km) 
 
 Restore Defaults will change everything to the default values, underlined above. 
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6. THE TOOLBAR 
 
This toolbar is displayed at the top of the screen on your PC when PC-Planner is running. 
 

 

 
Each of the Icons in the toolbar selects a different operation. Left clicking the relevant icon selects that mode and 
displays the icon in light gray to indicate it is active. PC-Planner will stay in that mode until another Icon is 
selected or the ‘Esc’ key is pressed to quit a particular mode. In this situation the program defaults back to the 
Pan mode.  Toolbar functions can also be accessed by right-clicking on the map in any mode except Zoom.   
 
Listed below is a brief description of each function on the toolbar. 
 

6.1. Shortcuts 
 

6.1.1. File Manager   

 
File Manager is the user point file management system in PC-Planner.  Each point of user data (waypoint, 
user point, route, track) entered into PC-Planner is stored into a buffer file called the PC-Planner memory.  
The data in this memory file can then be transferred to a User C-card, an SD-Card, a Furuno Memory 
Card, a C-MAP Floppy Disk or onto the local hard drive for backup purposes.   
 
All data is grouped together by data type.  Routes are saved as individual files per route.  User Points can 
be saved either as a group of all User Points, or in smaller groups based on the icons they utilize.  Tracks 
are saved as one file per track as well, regardless of the number of points in the track. 
 
File Manager combines all data transferring into one simple window.  File Manager will also allow for 
formatting of memory media and file management on the User C-cards (the SD-card and Furuno Memory 
Cards do not have individual files for the user data). 
 
File Manager is covered in length in Section 9. 
 

6.1.2. Print   

 
It is possible to print the chart that is displayed by clicking on the print icon in the toolbar.  A dialog box 
will appear on screen. Click on “OK” to print.  

 
Alternatively click on File in the Menu Bar and choose Print or select the Print option in the popup menu 
that appears right clicking on the map. To preview the page before printing, select Print Preview.  

 
There are an increasing number of optional devices that use the PC printer port to connect to the PC, 
such as Scanners, digital cameras, Zip drives, etc. and also the complexity of some printers that have 
special Printer Monitor software which disable/lock the printer port. For this reason, it is not uncommon 
for PC-Planner to conflict with other devices using the printer port. 

 
Should you encounter any problems with the PC not being able to communicate with the PC-Planner 
reader or the PC not being able to print whilst the cartridge reader is connected then the following steps 
should be taken: 
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• Disconnect, disable or uninstall any other software or devices that use the printer port. 
• Install a generic Microsoft Windows driver for the printer you have, rather than the more 

sophisticated driver supplied with the printer, which may try to take full control of the printer 
port. 

• Install a second printer port card in your PC which is dedicated solely to the PC-PLANNER MAX – 
these printer port cards are readily available from most PC retailers and cost less than $20 USD. 

 

6.1.3. Data Receiving   

 
By selecting this button, PC-PLANNER MAX enters into an “Active Waiting” state so that it will be ready to 
accept any compatible user point data from the PC serial port. The data format must be in NMEA0183 
format using the RTE and WPL messages. Only one route can be received at a time. 
 
The Data Receiving function can be enabled or disabled selecting the Data Receiving option in the popup 
menu that appears right clicking on the map. 

 
 
 

6.2. Chart Tools 
 

6.2.1. Pan  

 
To move around the charts (panning), left click the Pan icon or select the Pan option in the popup menu 
that appears by right clicking on the map. The cursor should now change to a hand shape and whenever 
you left click on the chart, the screen will redraw to display the cursor’s current position as the center 
point of the screen. By repeatedly moving the cursor to one side of the screen and left clicking, it is 
possible to quickly move around the chart in a particular direction.   

 

Tip 
This can also be accomplished by using the arrow keys on your keyboard. 

 

6.2.2. Zoom   

 
To zoom into a more detailed chart, select the Zoom icon on the toolbar or select the Zoom IN/OUT 
option in the popup menu that appears right clicking on the map. By left clicking on the charts, more 
detailed charts can be selected. To zoom out, right-click the mouse button.   
 
Tip 
This can also be accomplished pressing the “I” (for zoom in) and “O” (for zoom out) keys on your 
keyboard.  Alternatively, this can be done with the wheel on a wheel mouse as well. 

 
Clicking on the arrow, at the right of the icon, you can quickly select 
the scale of the chart from the drop down box.  All of the displayed 
levels of detail are shown. 
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Clicking on the ‘-‘ and ‘+’ buttons, or pressing the same key on your 
keyboard, you can make the chart smaller or bigger without changing 
the scale. The zoom factors vary depending on the level of detail you 
are at.  For instance a detailed harbor chart can be overzoomed 2 or 
3 times, and underzoomed only 3 or 4 times.  But a background chart 
cannot be overzoomed at all, while it can be underzoomed up to 6 
times.  This enables you to expand or contract a chart at one specific scale.  

This tool is only active when Flexi-Zoom is turned on. 

 
 
 

 

6.2.3. Chart Rotation   

 
Introduced in Version 11, PC-Planner now features a rotation tool allowing you to rotate the chart display 
to any direction. 
 

The diamond without the arrows, , is used to return the chart back 
to North Up, and will also display a radial dial in the lower left hand 
corner indicating the display bearing of the chart.  The red portion of 
the diamond is always pointing at True North (0 degrees). 

 
 
 
 
 
 

The diamond with the arrows  is a free-hand 
rotation tool, and allows you to rotate the chart 
however you would like.  Again, the red portion 
of the diamond always points to True North 
when complete, however during the rotating 
phase, the red arrow points, temporarily, to 
whatever bearing you wish to have. 
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6.2.4. Info   

 
C-Map charts contain a lot of additional information that is not displayed on the screen, such as warning 
notes, Port and Tide information, and names of navigational aids.  This is the beauty of vector 
technology.  The chart information tool provides easy access to all of this data. 

 
Select the Info button on the toolbar at the top of the screen or select the Info option in the popup 
menu that appears when right clicking on the map.  Left click on the point or the area you require 
information from, and a dialog box showing cartographic information will be displayed on the screen as 
shown below. 

 

 
 

This works in a similar way to Windows Explorer. By highlighting one of the icons displayed on the left-
hand side of the dialog box, the chart information for the icon will be displayed on the right of the dialog 
box.  For example, highlighting the depth area icon will display the depth range for the area you have 
clicked on.  

 
Tip 
This can also be accomplished by pressing and holding the control (Ctrl) key on the keyboard and left 
clicking on the chart object you wish to see information on, regardless of the function active at that time. 

 
 
 

NOTE: You can retrieve quick info about a User 

Point, about a Route or about a Nav-Aid, simply 

placing the mouse on the object. A popup 
window shows you the information. 
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6.2.5. A-B  

 
The A-B function allows measurements of the distance and bearing between two points, and can be 
activated by selecting the A-B icon on the toolbar or selecting the A-B option in the popup menu that 
appears right clicking on the map. 
 

Once the A-B function has been selected, the cursor will 
change to an “A” symbol. Left click on the first position on the 
chart and the “A” will be placed at that position. Move the 
cursor, which will now have changed to a B symbol, to the 
second position and left click again.  A red and yellow line will 
connect these two points.  The distance (Dist) and bearing 
(BRG) between the two points will be displayed on the 
bottom left hand corner of the screen as seen in the image to 
the left.  

 
It is only possible to have one A-B line shown on the screen 
at any one time.  When a new line is created, the original will 
disappear. If you do not wish to have an A-B line displayed 
anymore, simply click once to create the A position and then 
press the ‘Esc’ key on your keyboard or select the “delete” 
function and click on the “A” or “B” points. 

 
 
The Range and Bearing units are based on the settings applied in PC-Planner.  For more on setting these 
values, see sections 5.2.8 and 5.2.9 respectively. 
 

6.2.6. User Point/Route Functions   

 
These buttons are used for creating and editing User Points (Marks and Waypoints) as well as creating 
and editing Routes.  These functions are covered in detail in Section 7. 

 

6.2.7. Route Checking   

 

This button will enable or disable the Route Checking feature in PC-Planner.  Please refer to Section 5.6 
of the manual for information on configuring and using the Route Checking feature. 
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6.2.8. Perspective View   

 
This button toggles the perspective view of the chart display.  Perspective view is a type of ‘bird’s eye’ 
view of a chart, and can give you a more realistic perspective of the chart.  It also elongates the visible 
area of the chart, as seen in the images below: 
 

 
 

Perspective View OFF 

 

 
 

Perspective View ON 
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6.2.9. Chart Boundaries   

 
This button toggles the Chart Boundaries on or off.  The chart boundaries are the ‘ticked’ boxes surround 
the coastline.  Each box indicates an area where more detail is available. 

 

     
 

   Chart Boundaries ON          Chart Boundaries OFF  

 

6.2.10. Light Animation  

 
This button toggles the Light Animation setting.  When on the Light Animation will make all lighted 
navaids blink in their respective time periods.  When the light is not lit, the color ‘halo’ will be shaded 
gray, and then flash with the appropriate color.  As this is a non-static setting it is difficult to illustrate in 
the manual. 

 

         
 

 Light Animation OFF   Light Animation ON -   Light Animation ON –  

      In between periods   2 of 3 lights flashing 
 

6.2.11. C-Weather  

 
C-Weather is C-Map’s proprietary weather feature.  It allows you to download a 4 day window of weather 
data for a 180 x 180 nautical mile area.  The weather data can then be transferred to your chart plotter 
and overlaid on the chart data.  The weather data includes temperature, wind speed and direction, wave 
height and direction, weather conditions (sunny, clear, cloudy, etc), humidity and visibility.  This button 
initializes the download of weather data from the C-Map servers.  For further details and instruction 
please refer to the dedicated section on C-Weather in section 11. 
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7. USER POINTS AND ROUTES 
 

7.1. USER POINTS (MARKS AND WAYPOINTS) 
 
A User Point is a point that can be stored at any position on the chart.  On chart plotters these user points 
are often referred to as waypoints, marks or events.   
 
Using this feature any type of important position (fishing spots, dive locations, uncharted hazards, etc.) can 
be stored.  There are a number of different symbols available for this purpose and these are displayed on the 
left-hand side of the screen.  Depending on which emulation you are in some symbols may or may not be 
available.  Additionally, in the Furuno emulations, only certain symbols can be used for marks, and only 
certain ones can be used for waypoints. 
 

 

7.1.1. Add UP  

 
User points can be positioned on the chart by selecting the 
Add UP button on the toolbar or selecting the Add UP option 
in the popup menu that appears right clicking on the map. The 
cursor will change to that of the symbol chosen from the list 
down the left hand side of the screen. To insert a User point, 
simply place the cursor on the chart at the desired position and 
left-click. The User point will now be stored and displayed on 
the chart with the relevant symbol and an automatic name of 
UP XXX, where XXX is a running total of User points stored in 
PC-Planner, starting at 000. If you place the User point on a 
Nav-Aid, the Nav-Aid‘s name is given to the User point. 

You should also see a little drop down arrow  next to the Add 
UP button.  This will allow you to choose between a MARK and a WAYPOINT.  This is extremely important 
for Furuno users as Marks CANNOT have a name or a description in them.  Only Waypoints can contain 
this information.   
 
User Points can have names, descriptions and colors.  When first created the User Point is named as 
described above and the Description is ‘Generic User Point’.  These fields can be edited on the map 
screen by holding down the control key (Ctrl) and left-clicking on the User Point.  This will bring up the 
following dialog box allowing you to change all aspects of the User Point: Name, Description, Lat/Long, 
Icon and Color.  They can also be edited through the User Points List (User Data -> User Points List). 
 

 
 

Each of the emulations has a specific set of symbols and restrictions for Marks and Waypoints.  These 
restrictions are highlighted below: 
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Generic and Fish-12 SD 

 

Symbols (User Points/Routes) =  

Colors =  
Restrictions = Name must be 8 characters or less.  Description must be 30 characters or less. 
 
Furuno GP-7000 
 

Symbols (User Points/Routes) =  

Colors =  
Restrictions = Name must be 8 characters or less.  Description must be 30 characters or less 
 
Furuno Navnet1 and Furuno Navnet2 

 

Symbols (Marks) =  

Symbols (Waypoints/Routes) =  

Colors =  
Restrictions = Marks cannot have a Name or Description.  Waypoint names must be 6 characters or less.  
Waypoint descriptions must be 13 characters or less. 
 
Navman 8xxx and Northstar M Series 
 

Symbols (User Points/Routes) =  

Colors =  
Restrictions = Name must be 8 characters or less.  Description must be 30 characters or less. 

 

7.1.2. Del UP  

 
User points can be deleted by selecting the Del UP button on the toolbar or selecting the Del UP option 
in the popup menu that appears right clicking on the map, and left clicking on the User point to be 
deleted. It is also possible to delete User points from the User Point List (see section 8.1.4). 

 

7.1.3. Move UP  

 
It is possible to move User points to a new position with the Move UP button on the toolbar or by 
selecting the Move UP option in the popup menu that appears right clicking on the map and click and 
dragging the User point to the new position. Then release the left mouse button and the User point will 
now be placed in its new position. 
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7.2. ROUTES 
 

A route is a collection of linked User points. It is possible to include any of the existing User points in a route, 
or create new User points as you create a route.  It should be noted that any User points linked to a route 
will be deleted when the Route is deleted. It should also be noted that it is not possible to delete User points 
that are used in an existing route. In the User Point List window User Points that are part of a route are 
displayed with a lock symbol next to them and cannot be deleted until the route they are part of is deleted. 

 

7.2.1. Creating a new Route from the map screen  

 
The New Route button on the toolbar or the New Route option in the popup menu that appears right 
clicking on the map allows you to create a new route. Left click on the New Route icon and then left 
click on the first point of the route you wish to enter. The first waypoint (user point) in the route will now 
appear. 
 

As you move the cursor, a line originating from the first waypoint 
will be displayed. Move the cursor to the required position of the 
next waypoint and left click to position the next waypoint.  A 
black line with an arrow, indicating the direction of the route, will 
then appear connecting the first and second waypoints, as seen 
to the left. 

 
Further waypoints can be created, by repeating this procedure.  
If you wish to add existing User Points simply left click on them 
during the route creation procedure.  

 

Tip 

To use the same UP more than one time in the same route, press 
“SHIFT” while clicking on the point. 

 
 When you have finished entering your route, either press the 

‘Esc’ key on the keyboard or click on one of the other Mode 
Icons. As soon as you do either of these operations, a Route 
Name window will appear, and you will be prompted to give the 
route a name before it is saved. You can change the default 
name ‘Route XXXX’ and then click on the Create button to save 
the route or the Cancel button to exit and delete the route.  
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7.2.2. Editing a Route  

 
Existing routes can be edited by selecting the Edit Route button on 
the toolbar or selecting the Edit Route option in the popup menu 
that appears right clicking on the map. In this mode you can add or 
insert additional waypoints. To add a new waypoint to the end of a 
Route, simply go into Edit Route mode and left click on the route to 
edit.  This will bring up a transparent black line from the last waypoint 
in the route, and add a new waypoint wherever you click on the map.   

 
 
 
 
 
 
 
 
 
 
 
 

To insert a new waypoint into the middle of a route requires a 
little patience, and the following steps.  Go into Edit Route 
mode and left click on the route to edit.  This will bring up the 
same transparent black line from the last waypoint in the route.  
Now left click on the part of the route you wish to insert the 
waypoint into and HOLD the button down.  The leg of the route 
should now turn into a transparent black line and if you drag 
the mouse to a new spot and release it, a new waypoint will be 
inserted. 

 
The waypoints that you have entered for your route can be 
moved in the same way in which other User points can be 
moved.  Click on the Move UP button on the toolbar, click on 
the waypoint and drag it to the new position. 

 
In the same way, clicking on the Delete UP button in the 
toolbar, and then left clicking on the waypoint can delete a User 
point in a route.  . 

 
To exit the Edit Route mode, either press the ‘Esc’ key on your keyboard or select another mode from 
the toolbar. All changes to the route will be saved in memory. 

 
7.2.3. Creating a new Route from the User Points List  

 
You can also create a route using existing User Points that already exist in PC-Planner.  Open up the User 
Points List by going to User Data -> User Points List.  This will bring up a list of all User Points already 
stored in PC-Planner.  By selecting the desired User Point and then clicking on Add to Route you can 
build a route from these existing User Points.   
 
The first time Add to Route is clicked on the Save Route dialog box will appear.  Enter the name of the 
route and click OK.  Now the route is created, and you can proceed with building the route by selecting a 
new User Point and clicking on Add to Route.  When you have finished building the route, click Close 
on the User Points List window, and the Route will now appear on the screen and in the Routes List 
under User Data. 
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7.2.4. Advanced Route functions 

 
In the Routes List window (User Data -> Routes List), there are more options available for Routes.  
Each of them is described below.  

 
7.2.4.1. Renaming a Route 

 
A Route can be renamed by clicking once on the name of the Route on the left hand side of the 
Route List window.  It works much the same as renaming a file in Windows Explorer, where the 
name will become highlighted and you can type in a new name.    
 

         
 
7.2.4.2. Reversing a Route 

 
A Route can be reversed by clicking on the Reverse button on the Routes List window.  This will 
make the first waypoint now the last waypoint and the last waypoint now the first waypoint.  All 
other waypoints will be re-ordered accordingly as well.  Additionally the bearing and time for each leg 
will be recalculated as well. 
 
7.2.4.3. Renaming the Waypoints in a Route 

 
The waypoints in a route can also be renamed to fit the name of the route.  So, for instance, if the 
route name is TEST, then selecting Rename UP’s from the Routes List window will rename all of the 
waypoints so they are numbered with TEST in the name.  Waypoint 1 will now be TEST_1, Waypoint 
2 will be TEST_2, and so on. 
 
7.2.4.4. Copying a Route 

 
If the same few waypoints are used multiple times in routes (exiting a harbor, for example) then you 
can create one master route for the first few legs and then copy it multiple times to create larger 
routes.  Select the route you would like to copy and select Copy from the Routes List window.  A 
new route will be created with the same waypoints and speed/time data that may have been 
entered. 
 
7.2.4.5. Speed and Time Calculations 

 
Using either the default speed setting (see Section 
5.2.9) or by entering new values in the Routes List 
window, PC-Planner can approximate durations of 
routes.  Each leg will be calculated based on the 
default speed setting or it can be modified through 
the Routes List window by clicking in the Speed 
column.  The Leg and Total (Tot) Times will be 
automatically recalculated each time the speed is 
adjusted.  Additionally, a Start Time can be entered 
and an Arrival (Arr) Time will be calculated from the 
speed and distance provided for the route. 
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8. USER DATA 
 

8.1. User Points List 
 

The User Points List, found under User Data -> User Points List, contains 
all of the information for all marks and waypoints stored in PC-Planner 
memory.  From the User Points List it is possible to add, find, delete and 
create routes.  The following chapters will review each function. 

 
 
 

 
 
 
 
8.1.1. Adding User Points 

 
Click Add to insert a new User Point opening a pop-up window for information input: 
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8.1.2. Locating User Points 

 
Highlight the User Point to find and clock Locate to close the pop-up window and bring you to the User 
point on the map screen. 

 
8.1.3. Delete All User Points 

 
Highlight any of the User Points and click Delete All to remove all User Points from memory. 
 
8.1.4. Deleting User Points 

 
Highlight the User Point(s) to delete and click Delete Selected to remove them from memory.  It is 
possible to delete multiple User Points using the control (Ctrl) or Shift keys on the keyboard and tagging 
multiple User Points. 
 
8.1.5. Adding User Points to Routes 

 
Use the Add to Route button to add existing User Points to a new route.  Please refer to section 7.2.3 
for further information on this function. 
 
8.1.6. Searching User Points by Name 

 
To find a specifically named User Point, type in a few defining characters in the space beneath the 
Search by Name text and the User Points list will be filtered down to match your input. 
 
8.1.7. Transmitting User Points 

 
Highlight the desired User Point(s) and click the Transmit button to output the details of all existing User 
points in NMEA0183 format using the WPL message to the PC’s serial port selected in the General 
Settings menu. Some GPS and chart plotters will allow for this type of waypoint transfer, but you should 
check with the manufacturer of your GPS/chart plotter to see if this is possible and purchase a suitable 
PC interface cable from them. 
 
8.1.8. Printing User Points 

 
To print out a complete list of User Points click on the Print button. 
 
8.1.9. Hiding User Points 
 
User Points can be hidden from view on the chart screen by unchecking the icon located in the first 
column of the User Point information: 

 User Point will be displayed     User Point will be hidden 
 

 
 
 
 
 

 
 

 
 
 
 
 



PC-PLANNER   User Manual V.11.0x 

Page 35 of 60 

8.2. Routes List 
 

The Routes List, found under User Data -> Routes List, contains all of 
the information for all of the routes that have been created and stored 
in PC-Planner memory.  From the Routes List it is possible to copy, 
rename or reverse.  The following chapters will review each function. 

\ 
 
 

 
 

8.2.1. Renaming a Route 

 
A Route can be renamed by clicking once on the name of the Route on the left hand side of the Route 
List window.  It works much the same as renaming a file in Windows Explorer, where the name will 
become highlighted and you can type in a new name.    

 

         
 

8.2.2. Reversing a Route 
 

A Route can be reversed by clicking on the Reverse button on the Routes List window.  This will make 
the first waypoint now the last waypoint and the last waypoint now the first waypoint.  All other 
waypoints will be re-ordered accordingly as well.  Additionally the bearing and time for each leg will be 
recalculated as well. 
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8.2.3. Renaming the Waypoints in a Route 

 
The waypoints in a route can also be renamed to fit the name of the route.  So, for instance, if the route 
name is TEST, then selecting Rename UP’s from the Routes List window will rename all of the 
waypoints so they are numbered with TEST in the name.  Waypoint 1 will now be TEST_1, Waypoint 2 
will be TEST_2, and so on. 
 
8.2.4. Copying a Route 

 
If the same few waypoints are used multiple times in routes (exiting a harbor, for example) then you can 
create one master route for the first few legs and then copy it multiple times to create larger routes.  
Select the route you would like to copy and select Copy from the Routes List window.  A new route will 
be created with the same waypoints and speed/time data that may have been entered. 

 
8.2.5. Speed and Time Calculations 

 
Using either the default speed setting (see Section 
5.2.9) or by entering new values in the Routes List 
window, PC-Planner can approximate durations of 
routes.  Each leg will be calculated based on the 
default speed setting or it can be modified through 
the Routes List window by clicking in the Speed 
column.  The Leg and Total (Tot) Times will be 
automatically recalculated each time the speed is 
adjusted.  Additionally, a Start Time can be entered 
and an Arrival (Arr) Time will be calculated from the 
speed and distance provided for the route. 

 
Select the User Data menu at the top of the 
screen, and then select the Routes List option. A 
dialog box listing all Routes that have been created 
will be displayed on the screen: 

 
8.2.6. Deleting a Route 

 
Highlight the desired Route you wish to remove and click Delete… 
 
8.2.7. Deleting all Routes 

 
To delete all Routes in memory just click on Delete All to erase them all. 
 
8.2.8. Exporting a Route 

 
Highlight the desired Route and click Export to create a Comma Separate Value (CSV) file for the Route. 
 
8.2.9. Printing a Route 

 
Highlight the desired Route and click Print to make a paper copy. 
 
8.2.10. Transmitting a Route 

 
Highlight the desired User Point(s) and click the Transmit button to output the details of all existing User 
points in NMEA0183 format using the RTE and WPL messages to the PC’s serial port selected in the 
General Settings menu. Some GPS and chart plotters will allow for this type of waypoint transfer, but you 
should check with the manufacturer of your GPS/chart plotter to see if this is possible and purchase a 
suitable PC interface cable from them. 
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8.3. Tracks List 
 

The Tracks List, found under User Data -> Tracks List, allows you to 
view previously uploaded Tracks from your chart plotter.  The tracks 
can then be exported to file or transmitted to compatible devices.  The 
following chapters will review these functions. 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.3.1. Deleting a Track 

 
Highlight the desired track and click Delete… to remove it from memory. 
 
8.3.2. Deleting all Tracks 

 
To remove all tracks from memory, click on Delete All. 
 
8.3.3. Exporting a Track 

 
Highlight the desired Track and click Export to create a Comma Separate Value (CSV) file for the Track. 
 
8.3.4. Transmitting a Track 

 
Highlight the desired Track and click Transmit to output the details of the selected route in NMEA0183 
format using the PCMPT message (C-Map Proprietary message) to the PC’s serial port selected in the 
General Settings menu. 
 

 
 
 
 
 
 
 
 
 



PC-PLANNER   User Manual V.11.0x 

Page 38 of 60 

9. FILE MANAGER 
 

File Manager is the interface window for PC-Planner to transfer data from memory media (C-cards, SD-Cards, FP-
Cards, Floppy Disks) to PC-Planner and/or vice-versa.  It will take a little while to get used to, but once it’s been 
used several times it is quite simple.  As with the User Points, different plotter emulations require different 
handling of the User Data in File Manager and these processes will be reviewed below. 

 

9.1. Understanding the File Manager Window 
 

The File Manager window has a new look: 
 

 
 

 
 

            
 

       

       

      
 

 
      
 
 

This is where all data resides inside PC-Planner.  Any user data entered will end up 
in the PC-Planner memory. 

This is where the user data files will be listed.  Marks are grouped by icon type (as 
shown); routes and tracks will be grouped accordingly. 

These buttons select the User Data to be handled in the windows to the left and to 
the right of the buttons.  If you select Marks, then any Marks in PC-Planner memory 
will be shown on the left, and any Marks on the Target Drive selected on the right 
will be shown; same for Routes and Tracks, respectively. 

These two red arrows are used to transfer data from left to right (top arrow) or 
from right to left (bottom arrow).  In the screen shown, the top arrow would 
transfer from PC-Planner memory to User C-card, and the bottom arrow would 
transfer from User C-card to PC-Planner memory. 
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On the Target Drives side of File Manager, the options for PC-Planner readers will vary depending on what is 
connected: 

 
USBCC Reader 

 
USB Multimedia Reader  

 
 

USB FP Reader   

  
 

Now that you understand the File Manager window and what each panel and button does, it is time to 
elaborate on how to transfer data using this window.  As the process can be complicated the first few times, 
the exact steps are outlined below.  Please follow the instructions that pertain to your type of emulation, C-
Map C-card and USB Reader. 

 
 
 
 
 
 
 
 
 
 
 
 
 

This is where all files listed on the target drive (hard disk, SD-card, User C-card or 
Furuno Memory Card) will be listed.    

In this window, the destination drive for file transfer is selected.  It can be either a 
hard disk, SD-card, User C-card or Furuno Memory Card.    

This will exit the File Manager.    

The USBCC Reader has two C-card slots, and is the original PC-
Planner reader.  It is no longer in production but works with all 
versions of PC-Planner and will work with our latest MAX C-cards as 
long as PC-Planner is above version 10.   
 

The USB Multimedia Reader (MMR) has 3 slots, one for C-cards, one 
for SD-cards, and one for CF-cards.  The CF-card slot does not work 
yet at this time.  The C-card and SD-card slots are for C-MAP based 
media.  An off the shelf SD-card will work in PC-Planner, once it has 
been initialized. 
 

The USB Furuno Reader (FP) has 1 slot for the Furuno FP-cards used 
with the Navnet1 systems and the GP1650 and GP1850 plotters.  The 
file management procedures are different for these plotters and 
should be reviewed carefully below. 
 

This button will look for C-Weather files to transfer to the User C-card.   Please 
refer to Section 11 for information on C-Weather. 
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9.2. Transferring data to/from Hard Disk (All readers) 
 

NOTE: All procedures below are done with the PC-Planner memory on the left hand side and the Target 
Drives on the right hand side of the File Manager window.  It will work in reverse as well, but for 
simplification purposes the exercises are done with this layout. 
 
This procedure can be used to back up your User Data onto your hard disk for storage purposes, and 
combined with the ConvertXML utility, will let you edit and share the data.  Follow these steps to transfer 
data from PC-Planner Memory to the local Hard Disk (C:) 

 
1) Through My Computer or using Windows Explorer (outside of PC-Planner) create a 

destination folder for PC-Planner files.  It is easiest to put the folder on the root of the C-
drive.  In this example the destination folder will be C:\PCP_FILES.  Once you have created 
this folder, run PC-Planner. 

2) Once you have created the user data to save to hard disk, go into File Manager 
3) In File Manager, select the data set to transfer using the User Data buttons found in the 

lower half of the middle of the File Manager:   for Marks/User Points,  for Routes, 

or  for  Tracks. 
4) Once the data set has been chosen, a list of files of that data type will be displayed to the 

left in the PC-Planner memory files box: 

 
5) Click on the file to transfer, it will be highlighted in blue.  This will transfer only the one 

highlighted file.  It is also possible to select all the files and merge them into one file on the 
hard disk.  If you select the first file, and then hold down the SHIFT key and select the last 
file, all of the files will be highlighted in blue: 
 
One file selected….    All files selected…. 

     
6) Once the desired files are selected, the destination folder (that was created in step #1) must 

be chosen on the right hand side of the window.  This is accomplished by clicking on the plus 

sign next to where Windows is shown ( ).  This will bring up a list of the drives 

on the PC.  Now click on the plus sign next to Local Disk (C:) ( ) and this will 
list all folders on the C-drive.  NOTE: Not all PC’s have a C-drive called “Local Disk”.  On 
some PC’s the C-drive is labeled by the manufacturer (ie DELL) or the drive can be renamed 
by advanced Windows users.  Now select the PCP_FILES folder we created in step #1 above 

( ).  Now that this is done, the Target Drives files box will look like this: 
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7) With the source files selected, and our destination selected, all that remains is transferring 
and renaming (if desired) the files.  To accomplish this, simply click on the Transfer Right 

Arrow .  If there was one file selected (from step #5) then this dialog box appears: 
 

 
 
If multiple files were selected (from step #5), then this dialog box will appear before seeing 
the box above: 

 
Answering YES will go to the Edit File Name dialog box above.  Answering NO will go through 
the Edit File Name dialog box for each individual file.  So using the example in step #5, there 
would be consecutive dialog boxes allowing the files to be renamed.  Clicking on CANCEL will 
exit the File Transfer steps. 

8) If all the steps are followed above, there should be about a 2-3 second delay and the file will 
appear in the Target Drives file box with the name given in step #7: 

 
You have successfully transferred Marks from the PC-Planner to your Hard Drive! 

   
To transfer data from the hard disk back into PC-Planner memory, select the files on the 

right-hand side of the File Manager window and using the Transfer Left arrow  the 
files will be transferred back into PC-Planner memory. 
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9.3. Transferring data to/from User C-cards (USBCC/USBMMR) 
 

NOTE: All procedures below are done with the PC-Planner memory on the left hand side and the Target 
Drives on the right hand side of the File Manager window.  It will work in reverse as well, but for 
simplification purposes the exercises are done with this layout. 
 
This procedure will detail how to transfer data to a User C-card from PC-Planner memory, and back again.  
Once the data is on the User C-card, it can then be uploaded to a C-MAP chart plotter.  Please refer to your 
chart plotter owner’s manual for that procedure. 

 
1) Once you have created the user data to save to User C-card, go into File Manager 
2) In File Manager, select the data set to transfer using the User Data buttons found in the 

lower half of the middle of the File Manager:   for Marks/User Points,  for Routes, 

or  for  Tracks. 
3) Once the data set has been chosen, a list of files of that data type will be displayed to the 

left in the PC-Planner memory files box: 

 
4) Click on the file to transfer, it will be highlighted in blue.  This will transfer only the one 

highlighted file.  It is also possible to select all the files and merge them into one file on the 
hard disk.  If you select the first file, and then hold down the SHIFT key and select the last 
file, all of the files will be highlighted in blue: 
 
One file selected….    All files selected…. 

     
5) Once the desired files are selected, the User C-card must be chosen on the right hand side of 

the window.  If you have a USBCC Reader connected, then the slot holding the User C-card 
(left or right) must be selected.  If the USBMMR is connected, then the ‘C-card Slot’ needs to 
be selected.  Now that this is done, the Target Drives files box will look like this: 

 
 
 
 
 
 
 
 
 

The info line at the top indicates that there is a 128KB User 
C-card in the slot.  It has 100% of its memory free, and 
there are no files (out of a maximum capacity of 60 files) on 
the User C-card.    
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6) Now that the data files and the User C-card is selected click on the Transfer Right 

Arrow  to transfer the data to the User C-card.  If there was one file selected (from 
step #4) then this dialog box appears: 

 
 
If multiple files were selected (from step #4), then this dialog box will appear before seeing 
the box above: 

 
Answering YES will go to the Edit File Name dialog box above.  Answering NO will go through 
the Edit File Name dialog box for each individual file.  So using the example in step #5, there 
would be consecutive dialog boxes allowing the files to be renamed.  Clicking on CANCEL will 
exit the File Transfer steps. 

7) If all the steps are followed above, there should be about a 2-3 second delay and the file(s) 
will appear in the Target Drives file box with the name(s) given in step #6: 

 

 
 
You have successfully transferred Marks from the PC-Planner to your User C-card! 

   
To transfer data from the User C-card back into PC-Planner memory, select the files on the 

right-hand side of the File Manager window and using the Transfer Left arrow  the 
files will be transferred back into PC-Planner memory. 
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9.4. Transferring data to/from SD-Cards for Furuno GP7000 (USBMMR)  
 

NOTE: All procedures below are done with the PC-Planner memory on the left hand side and the Target 
Drives on the right hand side of the File Manager window.  It will work in reverse as well, but for 
simplification purposes the exercises are done with this layout. 
 
CONFIGURATION NOTE: In order to work with files properly formatted for the Furuno GP-7000, PC-
Planner must be set to GP-7000 mode by going to View -> Settings, and then on the General tab, changing 
the Plotter Emulation. 
 
This procedure will detail how to transfer data to an SD-Card from PC-Planner memory, and back again.  
Several Furuno plotters take the SD-card, but this procedure will ONLY be valid for use with the GP-7000 
series of plotters.  SD-cards for the NavNet2 (VX2) family of plotters have their own procedure for file 
transfer. 

 
1) Once you have created the user data to save to User C-card, go into File Manager 
2) In File Manager, select the SD-slot from the Multimedia Reader on the right hand side, where 

the Target Drives are listed. 

 
3) For the majority of SD-cards, the following error will be displayed: 

 
 
This is a simple warning advising that the SD-card is not properly initialized to handle saving 
of user data.  To initialize it, you must right-click in the Target Drives file box and select 
‘Initialize User Points File’ as shown below: 

 
 
Which will then lead to this: 
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Once you click OK, the initialization procedure will take place.  Initializing will take about 5 
seconds to complete, and simply sets aside a block of memory on the SD-card to handle data 
transfer.  It will not affect the chart data in anyway, and it only needs to be done once per 
SD-card.  When completed, the Target Drives file box will now reflect the change to the SD-
card: 

 

 
 
 

 
4) After the SD-card is initialized, select the data set to transfer using the User Data buttons 

found in the lower half of the middle of the File Manager:   for Marks/User Points,  

for Routes, or  for  Tracks. 
5) Once the data set has been chosen, a list of files of that data type will be displayed to the 

left in the PC-Planner memory files box: 

 
6) Click on the file to transfer, it will be highlighted in blue.  This will transfer only the one 

highlighted file.  It is also possible to select all the files and merge them into one file on the 
SD-card.  If you select the first file, and then hold down the SHIFT key and select the last 
file, all of the files will be highlighted in blue: 
One file selected….    All files selected…. 

     

7) Now that the data files and the SD-card is selected click on the Transfer Right Arrow  
to transfer the data to the SD-card.  If there was one file selected (from step #6) then this 
dialog box appears: 

 
 
 
 
 
 
 
 

The info line at the top indicates that there is 1MB of user 
data available on the SD-card.  It has 99% of its memory 
free, and there are 2 files (out of a maximum capacity of 60 
files) on the SD-card.    
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If multiple files were selected (from step #6), then this dialog box will appear before seeing 
the box above: 

 
Answering YES will go to the Edit File Name dialog box above.  Answering NO will go through 
the Edit File Name dialog box for each individual file.  So using the example in step #6, there 
would be consecutive dialog boxes allowing the files to be renamed.  Clicking on CANCEL will 
exit the File Transfer steps. 

8) If all the steps are followed above, there should be about a 2-3 second delay and the file(s) 
will appear in the Target Drives file box with the name(s) given during step #7: 

 

 
 
You have successfully transferred Marks from the PC-Planner to your SD-card! 

   
To transfer data from the SD-card back into PC-Planner memory, select the files on the right-

hand side of the File Manager window and using the Transfer Left arrow  the files will 
be transferred back into PC-Planner memory. 
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9.5. Transferring data to/from FP-Card (Navnet1) or SD-card (Navnet2) 
(USBFP/USBMMR)  

 
NOTE: All procedures below are done with the PC-Planner memory on the left hand side and the Target 
Drives on the right hand side of the File Manager window.  It will work in reverse as well, but for 
simplification purposes the exercises are done with this layout. 
 
CONFIGURATION NOTE: In order to work with files properly formatted for the Furuno Navnet1 series of 
plotters, PC-Planner must be set to FURUNO mode by going to View -> Settings, and then on the General 
tab, changing the Plotter Emulation.  For the Furuno Navnet2 series of plotters, PC-Planner must be set to 
NAVNET 2 mode. 
 
Transferring data to any of the NavNet series of plotters is the same, regardless of whether it’s done on an 
FP-card, or an SD-card, and whether it’s a NavNet1 or NavNet2 display.  While most chart plotters use 1 file 
for each User Data file (1 file for Waypoints, 1 file for Routes, etc), the Furuno systems use 1 file for all User 
Data, whether it contains Marks, Routes, Waypoints or Tracks, or all of them.   
 
Please pay attention to the instructions below as they will vary slightly for the SD-card versus the FP-card. 

 
1) Once you have created the user data to save to the SD-card or User FP-card, go into File 

Manager 
2) In File Manager, select the SD-slot from the Multimedia Reader, or the FP-card reader, on the 

right hand side where the Target Drives are listed: 

     
3) After clicking on either the SD-Slot of the MMR or the FP-Card Reader, one of the following 

dialog boxes will appear: 
     

  
 
This is the primary dialog box for transferring data in Furuno or NavNet 2 Emulation in PC-
Planner.  Notice there is no way to select individual files.  You must transfer all data for any 
given category or all data in all categories at once. 

4) IF either card (SD or FP) is being used for the first time, it should be formatted by selecting 
Format FP-Card or Card Format from the respective dialog box above.  Follow the on-
screen prompts until one of these messages appears: 
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5) Now that the card is formatted, click on the appropriate data sets to transfer in the Data to 
Transfer side of the dialog box and then click Execute Operation.  The following dialog box 
will appear: 

 
 
Click OK to finalize the transfer, and the following dialog box will appear: 

 
 

You have successfully transferred data from the PC-Planner to your Furuno media! 
   

To transfer data from the FP or SD-card back into PC-Planner memory, simply select the 
Load option in the Furuno Data Transfer Windows present in Step #3. 
 
Some other things to note regarding Furuno user data: 
• There is no way to verify the data on the card, as the files do not show up individually in 

File Manager like other User C-cards do.  If you see “Transfer Completed” like the last 
dialog box in Step #5 above, then the data is now present on the FP or SD-card and you 
are safe to transfer to the NavNet chart plotter. 

• Saving to the card will erase ALL prior user data stored on the card.  There is no 
appending to existing files with the Furuno formats. 

• Furuno is the only format that allows for Waypoints to exist outside of a route, and to be 
different than a Mark.  In Furuno and NavNet 2 emulations, the MARK is a Generic point 
that is limited to 6 icons and cannot contain a name or description.  A WAYPOINT is a 
more detailed point that has 14 different icons and can be saved with a name and 
description. 

The SD-card can be used to store data from both the GP-7000 and Navnet2 systems, as they can both use 
the SD-card, but contain different file formats for storing user data.  In order to transfer data from a GP7000 
to a Navnet2, you will need to use PC-Planner to ‘normalize’ the data.  Once data is transferred from a 
GP7000 into PC-Planner, you need to change the Plotter Emulation to Navnet2 and the icons and data will be 
changed to match the Navnet2 format, and the data can then be saved to the SD-card and uploaded into the 
Navnet2. 

 
 
 
 
 
 
 
 
 
 
 



PC-PLANNER   User Manual V.11.0x 

Page 49 of 60 

10. CURRENT PREDICTIONS 
 
C-Map charts include dynamic current arrows that adjust will show velocity and direction of the current all around 
the world.  The arrows change as time goes by, and can go from yellow, for a weak current, to dark red, for a 
strong current.  PC-Planner now has an improved current prediction interface making it easier to see the changes 
that will occur in the currents.  This section will review how best to utilize the full features of the current 
prediction tool. 
 
To enter the current prediction mode, you need to right-click on the chart screen and select Current Prediction.  
This will open up a new section on the toolbar that looks like this: 
 

 
 
The first drop down box is for the date.  You can select any date you want including past and future dates.  
When first initiated, the date will be the current date on the PC clock. 
 
The second box is for the time.  You can select any time here as well.  When first initiated, the time will be the 
current time on the PC clock. 
 
The third box is for Time Zone adjustments.  You should never need to activate this as the PC clock is adjusted 
for the correct time zone.  However, if you’re on the East Coast and were looking into currents on the West Coast 
for next week, then you would want to enter the time zone adjustment.  You have to click on the TZ button, and 
then the drop down box for the adjustment time will be active. 
 
The DL button is for Daylight Savings Time.  It is tied to the Daylight Savings setting in the General Setup (see 
section 5.2.10).  If Daylight Savings is turned on, then this button will be depressed, or active.  If Daylight 
Savings is off, then this button is inactive.  You can also click on it in this toolbar to activate or deactivate it. 
 

The last button (that looks like a clock) is the Current Animation setup.  The 
Current Animation will allow you to see the changes in currents over a desired 
period of time.  The animation will run for the indicated time frame, or until you 
switch out of the animation mode.  When you click on the clock icon, the dialog 
box to the left opens up. 
 
Here you can input the date and time range for the animation in the “From” and 
“Till” fields.  The “Time Shift” is the desired ‘step’ of the animation.  The “Refresh 
Rate” is how often you wish to see the changes drawn.  In this example, the 
hourly current changes will be redrawn every 5 seconds.   
 
If you click “Cyclic Animation” then the loop will repeat itself once completed.   
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11. C-WEATHER 
 
PC-Planner now has the capability to download weather information to your desktop.  The data can then be 
uploaded, via User C-card, to your chart plotter.  The weather data includes temperature, wind speed and 
direction, wave height and direction, weather conditions (sunny, clear, cloudy, etc), humidity and visibility.  A four 
day window covering a 180 x 180 nautical mile area will be downloaded. 
 
NOTE: Weather data is currently only available for the Mediterranean.  Other parts of the world will come online 
later in 2007.   
 
NOTE: C-Weather is a new feature for C-Map electronic charts and may not be compatible with your chart 
plotter.  Please contact your chart plotter manufacturer for compatibility. 
 

11.1. Downloading the weather data 
 

The first step in downloading weather is to select the forecast area.  Click on the C-Weather button  on 
the toolbar and the following dialog box will appear: 

 
While this dialog box is 
open, you will drop  a 
gridded pattern on the 
chart as you point and 
click.  This is necessary to 
pick the area of the world 
where the weather data 
will be downloaded for.  
Once you have decided on 
the area to retrieve 
weather for, click on the 
Download button on the 
dialog box to the left. 

 
NOTE: You must have an internet connection before 
proceeding with the download.  The weather data is 
stored on remote servers that PC-Planner will need to 
contact to retrieve the data from.  
 
Once the download of the weather data begins, the following status bar will be displayed: 
 
 

 
And then:  
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11.2. Viewing the weather data 
 

Now that the weather data is downloaded, the area originally chosen in the previous section will now be filled 
with weather icons: 
 

 
 

And a new toolbar will appear at the top of the screen: 
 

 
 

This new toolbar allows the following: 
 

Show Wind   
 
Displays the Wind speed and direction  
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Show Waves   
 
Displays the Wave height and direction 
 
 
 

Show Weather Type     
 
Displays the weather conditions 
 
 
 
 

Show Humidity    
 
Displays the relative humidity of the air 
 
 
 

Show Temperature     
 

Displays the air temperature 
 
 
 
 

Show Visibility    
 

Displays the range of visibility  
 
 

  These buttons will scroll through the layers of weather data detailed above.   
 

 
This drop-down box enables you to choose which layer is displayed without using 
the buttons above, or to turn off the weather display altogether 
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This drop-down box allows you to scroll to the desired times for data that 
was downloaded.  The first day is covered in 3 hour increments, the 
second day is covered in 6 hour increments and the third and fourth days 
are covered in 12 hour increments. 

 
Please bear in mind that with all weather forecasting, it is an inexact 
science, and the further into the future that is predicted, the lesser the 
reliability.  This weather data should not take place over prudent, local 
and current information available. 

 
 
 
 
 
 
 
 
 

Delete C-Weather File    
 
Causes the C-Weather file to be deleted from the PC Planner memory and the C-Weather toolbar to be 
hidden. It will appear again when you download a new file. 

 

11.3. Transferring the weather data to User C-card 
 
The weather data can now be transferred to a User C-card and uploaded to a compatible C-Map chart plotter 
for ready access while out on your boat.  Transferring the weather data is as easy as it is to transfer User 
Data. 
 

In File Manager there is now a C-Weather icon  in the middle column for data options.  If you click on 
this button, then any weather data will appear in the second panel of the File Manager Window, as seen 
below: 
 

 
 
Make sure a User C-card is loaded and selected on the right hand side, and then highlight the CWEATHER file 
and click on the arrow going from left to right in the middle column.  The file will transfer and you will be all 
set to take that User C-card to your plotter and upload the weather data to it (provided it has been upgraded 
to be compatible with C-Weather). 
 
For more on using File Manager to transfer files please refer to Section 9.3 of this manual. 
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12. FIND FUNCTIONS 
 
PC-Planner has the capability to find the following nearest 10 objects from the center of the screen: 
 

 
 

12.1. Ports by Name 
 

Selecting Ports by Name will bring up the 
dialog box to the left.  In the white box in 
the lower left hand corner, you can enter 
names or portions of names to filter down 
the complete list of Ports on a C-card. 
 
Locate 
After you select the Port, this will take you 
to its position on the chart 
 
Info 

After you select the Port, this will open up a 
new dialog box with the details of the 
facility. 
 
OK 

To close the dialog box. 
 

 

12.2. Nearest Ports 
 

Selecting Nearest Ports will bring up the 
dialog box to the left.  It displays the 10 
nearest Ports from the current cursor 
position. 

  

Locate 
After you select the Port, this will take you 
to its position on the chart 

 
Info 
After you select the Port, this will open up a 
new dialog box with the details of the 
facility. 

 
OK 
To close the dialog box. 
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12.3. Nearest Port Services 
 

Selecting Nearest Port Services will bring up the dialog 
box to the left.  It lists all the available services that a Port 
may contain.  Select which of the services you want to 
look for and click on Search. The dialog box below will 
now appear: 
 

 
 
Locate 

After you select the Port, this will take you to its position 
on the chart 
 
Info 
After you select the Port, this will open up a new dialog 
box with the details of the facility. 
 
OK 

To close the dialog box. 
 

 

12.4. Nearest Tide Stations 
 

Selecting Nearest Tide Stations will bring 
up the dialog box to the left.  It displays 
the 10 nearest Tide Stations from the 
current cursor position. 

  

Locate 
After you select the Tide Station, this will 
take you to its position on the chart 

 
Info 
After you select the Tide Station, this will 
open up a new dialog box with the tidal 
flow graph 

 
OK 
To close the dialog box. 
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12.5. Nearest Wrecks 
 

Selecting Nearest Wrecks will bring up 
the dialog box to the left.  It displays the 
10 nearest Wrecks from the current cursor 
position. 

  
Locate 

After you select the Wreck, this will take 
you to its position on the chart 

 
Info 
After you select the Wreck, this will open 
up a new dialog box with the details of the 
wreck 

 
OK 

To close the dialog box. 
 
 
 

12.6. Nearest Obstructions 
 

Selecting Nearest Obstructions will bring 
up the dialog box to the left.  It displays 
the 10 nearest Obstruction points from the 
current cursor position. 

  

Locate 
After you select the Obstruction, this will 
take you to its position on the chart 

 
Info 

After you select the Obstruction, this will 
open up a new dialog box with the details 
of the obstruction. 

 
OK 

To close the dialog box. 
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12.7. Nearest Objects 
 
You can search for various objects (buoys, lights, restricted areas etc.) by selecting one of them from the list 
below. 
 
The language used for the Object description depends on the language set in PC-Planner.   
 
NOTE: This function may be slow depending on the speed of your PC and the size of the C-card you are 
searching.  This engine performs a search compiling a list of ALL objects of a specified nature, and can be 
time consuming. 

 
 

Locate 

After you select the object, this will 
take you to its position on the chart 

 
Info 

After you select the object, this will 
open up a new dialog box with the 
information about the object. 

 
OK 

To close the dialog box 
 
 
 
 
 
 

12.8. Coordinate 
 

 
 
 

If you select Coordinate, a dialog box (see above) gets displayed, where you can enter Latitude and 
Longitude coordinates and have PC Planner MAX locate that point. "Create Mark" will also create a mark on 
the target position. 
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13. TROUBLESHOOTING 
 

13.1. General Questions 
 

Q: Which versions of Windows is my PC-Planner compatible with? 
A: PC-Planner is compatible with all versions of Windows except Windows NT. Windows NT does not support 
USB devices, and is therefore incompatible.  
 
Q: How and Why should I register my PC-Planner? 
A: You should register your PC-Planner to receive important notifications regarding updated software 
releases, updated drivers and any other updates regarding your software.   You will also have access to the 
SelectMarks database of wrecks, hangs, obstructions and reefs.  These are user point files you can download 
and upload into your PC-Planner.  Registration is now done on the PC-Planner website at http://pcplanner.c-
map.it and following the links to ‘Register Here’. 
 

13.2. Installation 
   

Q: When I insert the installation CD into my computer, nothing happens.  What should I do now? 
A: In some cases Windows does not detect the auto run file and you will have to manually run it. Open your 
MY COMPUTER icon and Right-Click the your CD-ROM Drive letter (usually D or E) and choose either 
“Browse” or “Explore”. Then Double-Click on the PCPNTAUTORUN.EXE file to run the installation. 
 
Q: During the installation on Windows XP, a prompt appears warning me that the software has not passed 
Microsoft Windows Logo Testing, and asks me to “Stop Installation” or “Continue Anyways”.  Which should I 
choose? 
A: You should choose “Continue Anyways”.  The Windows Logo Testing message is a default disclaimer 
Windows will display when installing drivers without a digital signature.  It is perfectly fine to install on your 
PC and will cause no harm to your PC.  This warning no longer exists with the new Multimedia Reader 
Drivers. 
 
Q: I have finished installing the software and the USB Reader. When I launch the software, a dialog box 
appears, asking for a Registration Code. Where do I find this? 
A: The Registration Code is included with your PC-Planner package on a letter from C-MAP.  Any time you 
update your software you will require a new Registration Code.  Please refer to the Troubleshooting section 
of this document for steps on how to do this. 
 
 

13.3. General Troubleshooting 
 

Q: Why do I get a pop-up box up telling me the ‘Registration Code not Valid” when I enter the Registration 
code I have? 
A: This can happen if you update the software.  Each version of PC-Planner requires its’ own Registration 
Code and older codes are no longer viable on the newer versions of PC-Planner.  Please refer to the 
Troubleshooting section of this document for steps on how to do this. 
 
Q: When I run the software it comes up in Demo Mode.  What is Demo Mode and why does it happen? 
A: Demo Mode is the default installation for PC-Planner.  It is an evaluation version of the software that 
allows you to try out the many features of PC-Planner without a reader being connected.  If you are getting 
Demo Mode with a USBCC Reader plugged in, that usually means the drivers are not synced with the 
computer, and you will need to review the driver troubleshooting document found on the PC-Planner website. 
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Q: When I try to save my information to a User C-card, I keep getting this message: “No user card present.” 
Why? 
A: For USBCC Reader Users => Make sure the correct slot is selected.  The User C-card can go in either the 
right or left-slot of the USBCC Reader.  Newer versions of PC-Planner will auto-detect and assign the 
appropriate side of the File Manager window to the slot of the USBCC Reader (If the User C-card is in the left 
slot, the left side of File Manager will be the User C-card, and vice-versa).  In older versions of PC-Planner, 
the slot needs to be assigned by the drop down box at the top of the File Manager window. 
For USB Multimedia Reader Users => Make sure you have selected the “C-card slot” from the new File 
Manager interface.  It’s contents will be displayed in a box next to the drive listing. 
 
Q: I transferred information to my User C-card, but now I can’t see it on my chart plotter. Why is this? 
A: The User C-card works like a floppy disk in a PC. It’s a medium used to transfer information from one 
place to another. The chart plotter does not read the User C-card like your chart C-card. In order to view 
your saved information, you’ll need to upload it from the user C-card into the memory of your chart plotter. 
Please refer to your chart plotter’s manual for instructions on doing this. 
 

13.4. Operational 
 
Q: How do I format a User C-card? 
A: In the File Manager screen, if you right-click with the mouse in the open window (when you have the user 
C-card selected), you can select “Format User card.” This will erase ALL data on the user C-card. 
 
Q: How do I transfer data to the user card? 
A: You will need to select the User C-card on one side of the File Manager’s window and the PC Planner 
Memory on the opposite side. Select the file you would like to transfer and click on the red arrow that points 
to the side the User C-card is represented on. This will send the files you have selected to the user card.  
 
Q: Do I have to have a MAX card to get MAX features on my PC-Planner? 
A: No. Perspective View, Flashing Navaids and Flexi-zoom will all work with your MAX C-card in PC-Planner, 
just as they would in your chart plotter. 
 
Q: What does the Anti-Grounding Alarm do? 
A: The Anti-Grounding Alarm is a safety feature that will scan through all chart layers to check a proposed 
route you are creating.  Using the settings found in VIEW -> SETTINGS, you can customize the Anti-
Grounding Alarm to search for anything from rocks to insufficient depth or obstructions.  PC-Planner will warn 
you if the Anti-Grounding Alarm identifies any hazards and asks if you would like to continue saving the 
route. 
 
Q: In the File Manager there is a Floppy Disk option.  When I try to save to a floppy disk I get an error 
message.  Why? 
A: The Floppy Disk option in File Manager is provided ONLY for owners of the SITEX Trawlplot and Fishplot 
12 chart plotters.  These chart plotters do not use User C-cards, but use specially formatted floppy disks 
available directly from SITEX. 
 

13.5. Advanced User Tips 
 

Q: Can I do anything with the user data outside of PC-Planner? 
A: Yes. You can save the data to your hard drive in XML format. PC-Planner has a ConvertXML.EXE program 
that will convert your XML format into a CSV (comma-separated value) file (found in PC-Planner under TOOLS 
-> ConvertXML). The CSV file can be opened in a spreadsheet or word processing program, allowing you to 
edit and manipulate the data on a global scale, rather than individually in PC-Planner.  XML files can then also 
be transferred via e-mail or other storage devices to friends and family. 
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Q: Can I print with PC-Planner? 
A: You can print in black and white directly through the PC-Planner. If you’d like to print in color, you’ll need 
to use the “Save Screen As…” function under the “File” menu. This will save a color screen shot into a PNG 
file that can be opened in a web browser. You can then print from the web browser, or you can do a variety 
of other things with this file (mark it up, draw on it, etc). 
 
Q: Are there any ‘hotkeys’ in PC-Planner? 
A: You can use the letters D/I for Zoom-in, or U/O for Zoom-out. Using the arrow-keys will pan the map one 
screen in the associated direction (this is a good one to remember, especially in Route Edit mode). In 
addition, the Page-Up/Page-Down keys will adjust the color depth of the PC-Planner to brighter or darker, 
respectively. 
 

14. PC-PLANNER MAX SUPPORT 
 
C-Map is committed to guaranteeing the highest quality of support and service to its customers. In order to 
achieve this objective, we urge you to register with us as soon as possible.  Registration is now done on-line via 
the PC-Planner website: 
 http://pcplanner.c-map.it 
 
If you are a new customer click on the link to “Register Here” or if you already have a user name and password, 
enter them into the appropriate blanks to access the website.   
 
Should you require any level of Technical Support, we can be contacted M-F, 8:30-5:00 EST, at 800.424.2627.  If 
you prefer, we can be reached via e-mail at pcplanner@c-map.com. 
 
 
Thank you for choosing C-MAP.......Happy Planning! 

 
 


